
 

 

 

 

 

 

 

 

 

 

 

 

Moodle Basics – A User Guide 
 

MARIUSZ GŁĄBOWSKI, JAKUB GRZELSKI,  
KONRAD ŚNIATAŁA PAWEŁ ŚNIATAŁA, MICHAŁ WEISSENBERG 

  



 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 



M. Głąbowski, J. Grzelski, K. Śniatała Paweł Śniatała, M. Weissenberg:  
Moodle Basics – A User Guide 145. 

 
Introduction 
 
This part of the book was developed as one of the main outputs of the Cyber 
Security - Training Students and Scholars for the Challenges of Information 
and Communication Technologies in Research and Studies for 
Internationalisation (Cyber F-IT) project. The authors aimed to bring together 
in one place the most important information on managing the various elements of 
the Moodle system. This part of the book was designed to facilitate the work of 
Moodle administrators (Part A) and teachers (Part B). Due to the different nature of 
the tasks and challenges faced by these groups, the document has been divided into 
dedicated parts.  
Part A (User Guide for Admin) indicates the procedure for installing the Moodle 
service on a Linux Ubuntu distribution. This is followed by a list of the stages 
required to properly secure the entire service, create and manage users, and manage 
the server on which Moodle is running. The description as a whole allows 
administrators to be aware of all the tasks in each individual stage that lead to 
creating the Moodle platform and makes the implementation much more 
straightforward.  
 
Part B (User Guide for Teachers) describes the most important areas of a teacher's 
daily work on the Moodle platform. The global management of the course template 
and its individual activities are presented. This allows the teacher to learn, step by 
step, about the administration of his/her course, the meaning of individual fields, 
and the possibilities of using various activities and resources. The first part describes 
the management of the course template, the choice of course views, and the settings 
for the entire course. This is followed by a discussion of the possibilities for 
managing individual topics within the course and a detailed description of all 
activities that can be added to the course and the procedure for adding them. The 
following section is devoted to the possibilities for creating student assessment. The 
types of questions that can be added to the course are described, corresponding 
examples, and a procedure for creating a test environment. The last section of Part 
B is devoted to backing the course up and restoring the course from an existing 
copy.  
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1 Course Creation 
 
This chapter describes the basic steps needed to create a Moodle on Ubuntu 20.04 
Server. 
 
1.1 Change Course Settings 

 
Steps to install Moodle on Ubuntu 20.04 Server: 
 
1. Connect to the server via SSH 
2. Make sure that the server is up to date by using: sudo apt update & sudo apt 

upgrade 
3. Install required MySQL and apache repositories: sudo apt install apache2 

MySQL-client MySQL-server PHP libapache2-mod-PHP 
4. Run secure MySQL installation: sudo MySQL_secure_installation. Remember 

to write down the password, you will need it in the next step  
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5. After installation, you will see the message: “All done!” 
6. Install additional software: sudo apt install graphviz aspell ghostscript clamav 

PHP7.4-pspell PHP7.4-curl PHP7.4-gd PHP7.4-intl PHP7.4-MySQL PHP7.4-
xml PHP7.4-xmlrpc PHP7.4-ldap PHP7.4-zip PHP7.4-soap PHP7.4-mbstring 

7. Restart Apache so that the modules are loaded correctly: sudo service apache2 
restart 

8. Install Git because we will be using it to update Moodle: sudo apt install git 
9. Change directory to /opt, we will put the Moodle core application code: cd /opt 
10. Download Moodle code: sudo git clone git://git.moodle.org/moodle.git 
11. Change directory to Moodle: cd Moodle 
12. Retrieve a list of each branch available and tell git which branch to track or use: 

sudo git branch -a; sudo git branch --track MOODLE_39_STABLE 
origin/MOODLE_39_STABLE 

13. Check Moodle version: sudo git checkout MOODLE_39_STABLE. You 
should see that branch is up to date 

14. Copy the local repository to /var/www/html: sudo cp -R /opt/moodle 
/var/www/html/ 

15. Set proper permissions to files:  
16. sudo mkdir /var/moodledata 
17. sudo chown -R www-data /var/moodledata 
18. sudo chmod -R 777 /var/moodledata 
19. sudo chmod -R 0755 /var/www/html/moodle 
20. Restart MySQL: sudo service MySQL restart 
21. Create a database for Moodle and Moodle MySQL user. Use a password that 

you enter in d): sudo MySQL -u root -p 
22. Create database: CREATE DATABASE moodle DEFAULT CHARACTER 

SET utf8mb4 COLLATE utf8mb4_unicode_ci; 
23. Create a user and password where it says „moodledude” and 

„passwordformoodledude” you should change to the username and password 
of your choosing: create user 'moodledude'@'localhost' IDENTIFIED BY 
'passwordformoodledude'; Remember to use a strong password, another way 
you will be informed to use a stronger password 

24. Set permission to user: 
GRANT SELECT, INSERT, UPDATE, DELETE, CREATE, CREATE 
TEMPORARY TABLES, DROP, INDEX, ALTER ON moodle.* TO 
'moodledude'@'localhost'; 
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25. Exit database: quit; 
26. Temporarily make the webroot writable by sudo chmod -R 777 

/var/www/html/moodle 
27. Go to http://IP.ADDRESS.OF.SERVER/moodle in your web browser and 

finish the installation 
28. Set the language to English and click on “Next” 
29. Change from ‘/var/www/moodledata’ to ‘/var/moodledata’ 
30. Type set as: “Improved MySQL(native/MySQLi)” 
31. Set a username and password like in 23. Other options set like on the screenshot:  

 

 
 

32. Read and then accept conditions and click on “Continue” 
33. Check if the server environment meets all minimum requirements. 
34. Read installation summary, then click on “Continue” 
35. Create a username and password for Moodle administrator. Set an email address 

and other optional fields. Then click on “Update profile” 
36. Set Moodle Full site name, time zone, short name for the site, and no-replay 

address. Then click on “Save changes” 
37. Now you can see Moodle dashboard  
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38. Set permission to file “config.PHP”: sudo chmod -R 0755 

/var/www/html/moodle 
 
1.2 Setting Password Policy for User 

 
To set a password policy, follow these steps: 
 
1. Go to “Site adm 
2. inistration => Security => Site security settings”   
 
At the bottom of the page, you will find password policy settings.  
Set following variables: 
 

− Password length: 8 
− Digits: 1 
− Lowercase letters: 1 
− Uppercase letters: 1 
− Non-alphanumeric characters: 1 
− Log out after password change: Yes 
− Remember username: optional 

 
1.3 Register 
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The next step is to register your domain on Moodle.org, you will receive security 
messages. If you do not want to register your domain, you can follow security 
alerts on http://moodle.org/security. 
2 Moodle Security 
 
2.1 Securing Moodle From the Point of View of Network Addresses 
 
If you know the IP address poll of your users, you can set a whitelist for IP addresses. 
Or the other way around, you can block addresses that should not have access to 
the Moodle website. You can do it in “Site administration => Security => IP 
blocker”. 
 

 
 
2.2 Notification of Excessive Number of Password Attempts 

 
Enable security notification in “Site administration => security => notification”. 
You will be notified if there are too many password attempts which may indicate a 
brute force attack.   
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− Display login failures: Yes 
− Email login failures to <choose your username> 
− The threshold to email notification: 10 

 
2.3 HTTPS Security  
 
Settings of HTTP security are in “Site administration => Security => HTTP 
security”. These settings should stay as they are by default. 
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2.4 Allow Indexing by Search Engines. 

 
To allow indexing by search engines, you need to open – “Site administration => 
Security => Site security settings”. 
 

 
 
Option “Allow indexing by search engines” should be set as “Nowhere”. 

 
2.5 Configure LDAP Authentication. 
 
To integrate Lightweight Directory Access Protocol (LDAP) accounts with Moodle 
go to “Site administration => Plugins => Authentication => LDAP server”. LDAP 
defines a standard method for accessing and updating information in a local or 
remote directory (database) in the case of a client/server model. The protocol is 
optimised for reading, browsing and searching directories. 
 
To configure LDAP authentication, you have to set: 
 
1. Host URL – specify LDAP hostname or IP address 
2. Distinguished name - If you want to use bind-user to search users. For example 

'cn=ldapuser,ou=public,o=org' 
3. Password: password to LDAP server 
4. User type: Depended on LDAP settings 
5. Context: List of contexts where users are located 
6. Search subcontext: Yes 
7. User attribute: Overrides the attribute used to name/search users. Usually, 'cn' 
8. The rest of the fields can be left as they are by default. For„ Data mapping (First 

name)” use „givenName”, „Data mapping (Surname)” – „sn”, „Data mapping 
(E-mail)” – „mail” 
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9. Now you can save settings by clicking on “Save changes” and then test settings 

by clicking on “Test settings” 
10. To import users go to “Site administration => Server => Tasks => Scheduled 

tasks”. Find “LDAP users sync job”. Set the time when Moodle will synchronize 
users with LDAP. Also, you can run synchronisation manually from the server 
CLI (Command-Line Interface). 

 

 
 
2.6 Support Contact 
 
To set support contact information, go to “Site administration => Server => 
Support contact”. There is the possibility to set up a support email address and 
designate a special user responsible for support. 
 
2.7 Secure Session 
 
To secure sessions and limit the use of server resources, set a limit for the user 
session. You can do it in “Site administration => Server => Session handling”. 
 
2.8 Efficiency 
 
To increase efficiency, you can allocate more memory to physical resources on your 
server. The default value is set to 512MB. You can change it at “Site administration 
=> Server => Performance”. 
 
2.9 Notifications 

 
By default, notifications about upgrades are on, and you should leave it as it is. 
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2.10 Quiz Hardening 
 
Quiz hardening – limit access to quizzes with a password. To enable the option to 
set a password on a quiz, go to “Site administration => Plugins => Activity modules 
=> Quiz” and enable “Require password”. 
 
Quiz hardening – randomise question answers order. The default value of “Shuffle 
within questions” is enabled and can be changed in “Site administration => Plugins 
=> Activity modules => Quiz”. 
 
2.11 Brute Force Mitigation 
 
The built-in mitigation to the brute force is located in “Site administration => 
Security => Site security settings => Account lockout threshold”. Here, we can set 
a threshold of the number of failed login attempts that result in account lockout. 
These settings should be considered because the attacker can lock the account and 
consequently prevent access to the actual account owners. 
 
2.12 XSS/XSRF Mitigation 
 
XSS consists of injecting malicious code into a web form or web address in order to 
perform a given operation. So there is a special function that can clean input data. 
This function can be enabled in “config.PHP” file on your server. 
 
2.13 SQL Injection Mitigation 
 
Changing settings relating to Structured Query Language (SQL) Injection attacks is 
impossible. The only mitigation is in the source code of Moodle, which cannot be 
edited. So, it is important to keep Moodle up to date. 
 
2.14 Server Hardening 
 
On the server which is running Moodle, only necessary services should be running. 
Useful tools to audit the server can be “Tiger” or “Lynis” 
(https://github.com/CISOfy/lynis.git). They can be used to generate a report about 
the machine. 



158 
CYBER SECURITY - TRAINING STUDENTS AND SCHOLARS FOR THE CHALLENGES OF INFORMATION 

AND COMMUNICATION TECHNOLOGIES IN RESEARCH AND STUDIES FOR INTERNATIONALISATION. 

 
2.15 Server Hardening – Local Firewall 
 
The server should run a local firewall. The firewall should have ports needed for 
Moodle to function open properly. The necessary ports are 80, 443 (HTTP/HTTPS) 
and 9111 (chat). Example of access control list configuration:  
 

sudo apt install iptables 
sudo iptables -F 
sudo iptables -A INPUT -i lo -j ACCEPT 
sudo iptables -A OUTPUT -o lo -j ACCEPT 
sudo iptables -A INPUT -m state - -state ESTABLISHED, RELATED -j 

ACCEPT 
sudo iptables -A INPUT -p tcp - -dport 22 -j ACCEPT 
sudo iptables -A INPUT -p tcp - -dport 80 -j ACCEPT 
sudo iptables -A INPUT -p tcp - -dport 443 -j ACCEPT 
sudo iptables -A INPUT -p tcp - -dport 9111 -j ACCEPT 
 

To check settings, use:  
 

sudo iptables -nvL 
 

And at the end, add a policy to drop anything else: 
 

sudo iptables -P INPUT DROP   
 
2.16 Logs Storage 
 
Logs stored locally are located in “Site administration => Reports => Logs”. Logs 
can be filtered by participants/days/activities/actions sources/events. Logs are also 
stored in course backups if the proper option was chosen. Logs can also be exported 
to an external system, where they can be stored and analysed. Logs from Moodle 
and the server should be stored on a separate server. This can be done with 
“rsyslog”. Installation and configuration:  
 

sudo apt install rsyslog 
sudo systemctl start syslog 
sudo vi /etc/rsyslog.conf 
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Then add the following line to the file: 
 

*.* @@<adres_IP_serwera_syslog>:514 
 

Now save the file and restart rsyslog: 
 

sudo service rsyslog restart 
 

2.17 Logs Storage 
 
The administrator can set verification of the age and location of the user by enabling 
the options in “Site administration => Users => Privacy and policies => Privacy 
settings”. By default, these settings allow you to configure the website according to 
the rules of the GDPR, allowing verification of the age of users. These settings 
should align with local policy (see Section “Privacy Settings”). It is also possible to 
enable/disable the display of a summary of stored private data. Next, in “Site 
administration => Users => Privacy and policies => Policy settings,” we can add 
URL to the data storage regulations, the website policy guide. In the “Site 
administration => Users => Privacy and policies => Plugin privacy registry”, there 
is a summary of the data collected by plugins installed on the platform. In “Site 
administration => Users => Permissions => User policies”, the administrator can 
change the visibility of profile elements of users. 
 
3 Backup, Restore and Update 
 
3.1 Creating a Backup Copy of a Course – Manual Mode 

 
To create a manual backup copy of a course, you need to choose the course, click 
on the “gear” icon, and choose “backup”. 
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You will be redirected to a page with backup settings. There you can choose what 
data will be stored in the backup. You can jump to the final step or go for the next 
settings. On the second page, there are schema settings. In the third step, you can 
see a review of chosen settings and change the backup’s filename. To 
finalfinalisebackup, click on “Perform backup”. You should see the message “The 
backup file was successfully created.” After this process, you can download the 
backup file and store it in a secure location. 
 
3.2 Creating a Backup Copy of a Course – Automatic Mode 
 
An automated backup schedule can be set in “Site administration => Courses => 
Backups => Automated backup setup.”  
 

 
 
− Active: Enabled 
− Schedule: Saturday (Copy should be performed when the server is not busy. 

Running the backup tool over all the courses can be processor-intensive, so you 
should not run it when there are many students on the server.) 

− Execute at 00:00 
− Automated backup storage: Course backup file area. Backups should also be 

stored on another server in case of failure. 
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− Maximum number of backups kept: 10 
− Delete backups older than: depends on administrator choice 
− Skip courses not modified since: 30 days 
 
3.3 Course Restore – Manual Mode 

 
To restore course data, you need to go to the chosen course, click on the “gear” 
icon, and then “restore”. 
 

 
 
The course can be restored from a backup file stored on Moodle or from an external 
file.  
 
After selecting the file, you will see a page with a summary. If the copy is correctly 
restored, you will see “The course was restored successfully, clicking the continue 
button below will take you to view the course you restored.” 
 

 
 

3.4 Moodle Upgrade – Backup Important Data 
 

Important data: 
 

− Moodle software (everything in server/htdocs/moodle) 
− Moodle uploaded files (server/moodledata) 
− Moodle database (your Postgres or MySQL database dump) 
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 cp moodle moodle.backup 
 mv moodledata moodledata.backup 
 MySQLdump -u username -p -C -Q -e -a moodle > 

moodle-backup.sql 
 

Put your site into maintenance mode to stop any non-administrator user from 
logging in. Then wait for any currently running cron processes to complete before 
proceeding.  
 

 
 
Check the requirements “Site administration => Server => Environment”  
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Download new files from Moodle and then unpack them: 
 

tar xvzf moodle-1.1.tgz 
 

Then copy the file: 
 

cp moodle.backup/config.PHP moodle 
cp -pr moodle.backup/theme/mytheme moodle/theme/mytheme 
 

Now disable maintenance mode for everybody to be able to reaccess the Moodle. 
 
4 User Account Settings 
 
4.1 Role Settings 

 
Default roles and their permissions are in “Site administration => Users => 
Permissions => Define roles”. 
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Here you can create a role or edit an existing role. To edit the role, click on the 
“gear” icon on the right side. The roles and permissions should have been matched 
to the platform and users. If a permission is dangerous, there will be a red triangle 
on the right side with a description. 
 

 
 
The granted rights should be set as low as possible while still allowing users to 
perform their tasks and properly use the platform. 

 
4.2 Privacy Settings 

 
Privacy settings are located in “Site administration => Users => Privacy settings”, 
and these are variables responsible for user privacy. By default, settings are 
customized to the chosen location. This means that when a new user selects the 
'Create new account' button, they will be asked to enter their age and the country 
they are from. 
 

 
 
4.3 Authentication 
 
Users can log in to the platform using local accounts created on the server or external 
authentication servers, such as the LDAP server. In “Site administration => Plugins 
=> Authentication => Manage authentication” administrator can connect the 
external server to Moodle. 
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To activate the pre-installed plugin, we need to first configure it by clicking on 
“Settings” and then try it by clicking on “Test settings”. If the test passes, we can 
enable the configuration by clicking on the “eye” icon. 

 
4.4 Permission Summary 
 
To display permissions of users go to “Site administration => Users => Accounts 
=> Browse list of users”.  
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Users can be filtered by various filters, that are hidden under “Show more”. This 
way, accounts can be modified or removed from the platform. Only trusted 
administrators should have permissions to browsers users' accounts and modify or 
remove them. 
 
4.5 Role For All Users 
 
Under “Site administration => Users => Permissions => User policies”, it is 
possible to define default role for all users. 
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4.6 Adding Administrator 
 
To add another administrator of Moodle go to “Site administrator => Users => 
Permissions => Site administrators”. In GUI we can add or remove administrators.   
 

 
 
5 Server Settings 
 
5.1 Developer and Testing Environment 
 
The test environment should be an exact copy of the production site. It allows to 
test changes and evaluate platform behaviour. The administrator will be able to 
check the impact of changes on the server. The test environment should be 
accessible only from the internal network, with no access from the outside world, 
and isolated from the production server. The version of the development 
environment software should be the same as the version on the production server 
with the same config and plugins. Every change should be first tested on the 
development server. Testing the server is essential for continuous integration. After 
the test and positive results, the changes can be implemented on the production 
server. 
 
5.2 Health Monitoring of the Server 
 
Continuous monitoring of the server will allow you to notice irregularities in the 
work of the server. The server can be monitored by SNMP or special agents installed 
on the server. Health data collected by the monitoring server can be automatically 
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processed. Due to this, if the threshold is exceeded or events specified by the 
administrator occur, the administrator will be informed about the server state 
changes. Such events can be running out of disk space, CPU overheating, or loading 
on the network link to the server. Systems such as LibreNMS or Zabbix allow you 
to configure your triggers. Thanks to the long-term analysis of data collected by the 
system, the administrator will be able to configure alarms for events occurring in a 
server environment. If the trigger is activated, the action can be an e-mail or SMS. 
Active monitoring of the server’s health can alert you about the strange behaviour 
of the server. It may mean that an unauthorized user has access to the server. 
  
5.3 Automatic Vulnerability Search on the Server 
 
Opensource tools allow you to test the platform. Tools like “BurpSuite” can easily 
test the impact of attacks on path traversal, XSS, SQL Injection, XSFR, SSRF. 
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1 Course Homepage 
 
The most important navigation elements on the course page: 
 

 
 
1. List - access to the side panel 
2. Gears - access to course management 
3. Notepad - course editing mode 
4. My courses - a list of the user's currently active courses 
 
2 Course Creation. 
 
This chapter describes the basic steps needed to create a course and how you can 
modify course elements, and how they affect the course, and how it is delivered. 
 
2.1 Change Course Settings 
 
This section covers the basic changes you can make to your course settings. To make 
changes, go to the subpage that allows you to change the course settings, available 
in the course settings panel. 
 
2.1.1 Course Name 
 
The name of the course should reflect the subject of the course. It is visible to users 
on the list of courses in which they participate and in the appropriate course category 
in the form of a link and in the navigation panel tab. After entering a given course, 
it is also displayed in the title bar of the web browser. 
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To rename a course, follow these steps: 
 

1. Enable access to course management ("gears") 
2. In the Course Settings pane, select Change Course Settings 
3. In the "Full Course Name" field at the top of the page, enter a name for the 

course 
4. Scroll to the bottom of the page and click on the Save and Display button 

 
2.1.2 Course Visibility 
 
Specify whether the course is to be visible to students after entering the appropriate 
subcategory and whether enrolled students are to see their course in their navigation 
panel. By default, a newly created course remains in the hidden state. 
In a hidden state, the course remains visible to the course author and teachers 
assigned to it, and to people with administrative privileges. While it is hidden, 
students cannot access or see the course in the navigation pane even after they enrol 
in it. 
 
To hide/show a course, follow these steps: 
 

1. Enable access to course management ("gears") 
2. In the Course Settings panel, select Change Course Settings 
3. In the "Course Visibility" field, select the assumed option from the drop-

down menu 
4. Scroll to the bottom of the page and click on the Save and Display button 

 
2.1.3 Course Format 
 
Course format refers to the course layout. The course format can be set by following 
these steps: 
 

1. Enable access to course management ("gears") 
2. In the Course Settings pane, select Change Course Settings 
3. In the "Course Format" pane, go to the "Format" drop-down menu and 

select one of the options 
4. Scroll to the bottom of the page and click on the “Save and Display” button 
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There are several course formats, including: 
 

− Weekly format - the format in which Moodle will create a separate section 
for each week of the course, including the dates in the header. The current 
week is automatically highlighted, and resources, activities can be placed in 
each section. 

− Topics format (the default form of the course) - the format in which the 
course is divided into thematic sections with names specified by the teacher. 
Within each topic, you can include activities, resources and labels. 

− Social format - a format focused on a social forum in which the facilitator 
can place any number of thematic discussions. 

− Single activity format - the format in which the curse is divided into only a 
single section in which the teacher can only place one activity. 

 
Detailed descriptions are available at: 
https://docs.moodle.org/310/en/Course_formats. 
 
2.1.4 Course Start and End Date 
 
The course start date affects how the course and logs are displayed, especially when 
selecting the weekly course format. The course end date is used to determine if the 
course should be included in your course list. After the end date has passed, the 
course is no longer displayed in the navigation block and is listed as past in the course 
overview on the student dashboards.  
 
To set the start and end date of the course, follow these steps: 
 

1. Enable access to course management ("gears") 
2. In the Course Settings pane, select Change Course Settings 
3. In the "General" panel, specify the start and end date of the course 
4. Scroll to the bottom of the page and click on the Save and Display button 

  



174 
CYBER SECURITY - TRAINING STUDENTS AND SCHOLARS FOR THE CHALLENGES OF INFORMATION 

AND COMMUNICATION TECHNOLOGIES IN RESEARCH AND STUDIES FOR INTERNATIONALISATION. 

 
2.1.5 Course Description 
 
The course description is divided into two sections: course summary and course 
image. To add a course description or image, follow these steps: 
 

1. Enable access to course management ("gears") 
2. In the Course Settings pane, select Change Course Settings 
3. In the "Description" panel, complete the course summary and add a course 

image 
4. Scroll to the bottom of the page and click on the Save and Display button 

 
2.1.6 Course Summary 
 
The summary will appear on the course list page. This field is searched when 
searching for a course and also appears in the course description block. 
 
To add a course summary, follow these steps: 
 

1. Enable access to course management ("gears") 
2. In the Course Settings pane, select Change Course Setting 
3. In the "Course Summary" panel, add a summary of the course 
4. Scroll to the bottom of the page and click on the Save and Display button 

 
2.1.7 Course Image 
 
You can attach an image to your course summary. It will be available to anyone 
outside the course, as will the course name and summary. The course image is 
displayed as an icon in the list of available courses. 
 
To place a course image, follow these steps: 
 

1. Enable access to course management ("gears") 
2. In the Course Settings pane, select Change Course Settings 
3. In the "Course Image" panel, place an image file in one of the accepted 

formats: .gif, .jpeg, .png. 
4. Scroll to the bottom of the page and click on the Save and Display button 
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2.1.8 Files and Uploads 
 
It allows you to specify the maximum file size that can be sent by a student within 
the course. In the Moodle distribution used within the Cyber F-IT project the default 
is 500 MB. 
 
To change the settings for the uploaded file size, follow these steps: 

1. Enable access to course management ("gears") 
2. In the Course Settings pane, select Change Course Settings 
3. In the "Files and Upload" panel, select the maximum size of the uploaded 

file from the drop-down menu 
4. Scroll to the bottom of the page and click on the Save and Display button 

 
2.1.9 Groups 
 
It allows you to change the course settings to divide users into groups. To change 
these settings, follow these steps: 

1. Enable access to course management ("gears") 
2. In the Course Settings pane, select Change Course Settings 
3. In the "Groups" panel, you can change the selected options (described 

below) 
4. Scroll to the bottom of the page and click on the Save and Display button 

  
2.1.10 Group mode 
 
In this section, you can define group mode at the course level using the drop-down 
menu. The options are "No Groups", "Separate Groups", and "Visible Groups". 
The selected setting will be the default group mode for all activities defined in this 
course. The group setting can affect what users see in the attendee list and with 
whom they can interact in the activities. 
 
If you select "No groups", no user subgroups are created within the course, and 
activities are assigned by default to all participants. 
 
When selecting "Separate Groups" in the course, each of the created groups sees 
only its group. 
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On the other hand, when selecting "Visible groups", the participants work within 
their subgroups but can see other groups in read only mode. 
 
2.2 Course Management 
 
This chapter describes the basic ways to manage users. The focus will be on the 
possible ways of enrolling students and teachers in the course, their data, and course 
roles. In addition, it will show how to create groups and assign students to them, as 
well as filter students on the list of participants. Additionally, the methods of 
contacting students and reports on their activity in the course will be discussed. 
 
2.2.1 Course Enrollment Methods 
 
Within the Moodle platform, there are several basic methods of adding students to 
a course. 
 
Changes to the enrolment methods can be made as follows: 
 

1. Enable access to course management ("gears") 
2. In the User links panel, select Enrolment Methods 
3. In the "Add enrolment method" field, select one of the options described 

below from the drop-down list 
 
Within the Moodle platform, you can add the following user enrollment methods: 
 

− Manual Enrolment – manual registration of users allows the teacher to 
assign users to the course on their own. There are two ways to do this. 

− After entering the "Enrolment methods" section (see above), in the 
list of saving methods, we find "Manual enrolment", and then in 
the modify column, select the "Save users" option. 
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− After enabling access to course management, in the User links 

panel, select the Participants tab (also available in the side panel). 
Then select the "Enrol users" button. 

 

 
 

− Self-enrolment – enables users to enrol by themselves for the course by 
entering the password entered by the course creator. It is possible to define 
the time during which the user is allowed to enrol and the maximum number 
of users who can enrol in the course. 

− Enter your name for the saving method (any name). 
− Enter the access key to be made available to students. 
− Define the default role after accessing with a specific key; the 

default role is a student (description of roles available in the "course 
roles" section). 

− Set the start and end date of the period in which students can enrol 
(in the absence of a date, the student may enrol in the course at any 
time). 

− Cohort sync – you add a group of users to the course. It is intended for 
student groups, academic year, etc. To add users via a cohort, follow these 
steps: 

− After enabling access to course management, in the User links 
panel, select the Participants tab (also available in the side panel). 
Then select the "Save users" button and in the “Select”, a cohort 
section, select one of the possible cohorts from the drop-down 
menu (the Moodle platform administrators on the university side 
deal with assigning cohorts to specific groups of subjects). 
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2.2.2 User Data 
 
To obtain information about students enrolled in the course, go to the Users 
subpage. 
 
To do this, follow these steps: 
 

1. Enable access to course management ("gears"). 
2. In the User Link panel, select Users. 

 
The following fields are visible on the list of users: 
 

− First name and last name 
− Student index number 
− E-mail 
− Faculty 
− Field of study 
− Role in the course (for a description of the roles, see the Course roles 

subsection) 
− Information about belonging to a group 
− Date of last access to the course - the last time the student accessed the 

course 
− Status 

 

 
 
In addition, by clicking on the name and surname of a specific student, you can get 
additional information, such as: 
 

− Form of study. 
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− Type of study. 
− Semester. 
− Dean's group. 
− Access to the full student profile.. 
− Add notes to the student. 
− View specific student forum entries within the course. 
− View the discussions started by the student in the course. 

 

 
 

Additionally, it is possible to generate several reports. This is described in the next 
subchapter for the user. 
 
2.2.3 User Reports 
 
To obtain user reports, follow these steps: 
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1. Enable access to course management ("gears"). 
2. In the User Link panel, select Users. 
3. Then click on the name and surname of a specific student. Select one of the 

reports to be generated. 
 

 
 

We can distinguish several types of reports: 
 

− Today's logs - information about the user's activity on a given day within 
the course. The logs include: 

− Time - the exact date of the event. 
− Full name - name and surname of the student. 
− Applies to the user - in the case of an activity in the course, defines 

the activity to which the user has access. 
− Component - an activity to which the student has gained access. 
− Name of the event - the operation that the student performed in 

the activity. 
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− Description - a short description of the event. 
− Source - definition of the browsing source, e.g., web in the case of 

a website. 
− IP address - the address from which the access was obtained. 

 
 

− All logs - information about users' activity within the course throughout its 
duration. It contains the same data as today's log report and activity graph. 
 

 
 

− Report summary - information about the user's activity within specific 
topics, such as the number of views on individual activities, obtained ratings 
in the activities. 
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− Full report - an extension of the report summary with attached files, and 
comments about the tasks. 

− Statistics - a collection of information about the number of views, entries, 
and all activities in the course, broken down by month. 
 

 
 

2.2.4 Course Roles 
 
In the course, we can define several basic roles that can be assigned to users: 
 

− Site administrator - By default, the course administrator is authorized to 
perform all operations in the course. 

− Course creator - can create and manage a course by adding users, blocks, 
and changes course settings. This role is often associated with the person 
teaching a given course. Still, it can also be assigned to the tutor of a given 
field of study or the curriculum coordinator. 

− Teacher - by default, the teacher within the course has the right to add and 
change blocks within the course, add activities and users. Additionally, the 
teacher can change the role of users (in terms of students and teachers 
without editing rights). 

− Non-editing teacher - has the right to view and rate student work but does 
not have the right to change or add new resources in the course. 
Additionally, you can restrict non-editing teacher access to specific groups 
within the course. 

− Student – has the right to participate in the course and has access to the 
course resources but may not edit the course or view the grading log. You 
can also restrict student access to specific resources by their name, 
identification number (e.g., index number), specifically assigned group, etc. 
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2.2.5 Group Creation and Administration 
 
Entering groups in a course allows you to filter actions and grades for specific user 
groups and grant non-editing access to teachers and students to specific activities, 
resources, and topic sections. 
 

− Group levels 
 

− Course level - selecting this level assigns group mode as the default 
mode for all added activities within the course. To enable this level, 
follow the steps described in the Course Creation chapter, 
subchapter Change Course Settings - Groups. 

− Activity level - for each activity that supports group mode, it can 
be assigned independently. The assignment of group mode to a 
single activity has been described individually for each activity. 
 

To create a new group, follow these steps: 
 

1. Enable access to course management ("gears") 
2. In the User Link panel, select Groups 
3. Select Create Group 

 
Another way to access groups is to follow these steps: 
 

1. Enable access to course management ("gears") 
2. In the User Link panel, select Users 
3. Select the group field from the drop-down menu with additional options 
4. Select Create Group 
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When creating a group, you can specify, among other things, the following 
parameters: 
 

− Group name - the name visible to the teacher in all activities for which 
group operations can be performed. 

− Group information - optional information about the group 
− Access key to the group in the case of individual registration by course 

participants. 
− Messages to the group - It allows members of the group to send messages 

to other participants. 
 

To add new users to the previously created group, follow these steps: 
 

1. Enable access to course management ("gears") 
2. In the User Link panel, select Groups 
3. On the list of groups, select the group to which you want to add students 
4. Then click on the Add / Remove Users button 

 

 
 

5. Select the student who is to be added to or removed from the group and 
select the appropriate button 
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2.2.6 Filtering the List of Users 
 
To filter the user list, follow these steps: 
 

1. Enable access to course management ("gears") 
2. In the User Link panel, select Users 
3. At the top of the page, select the filtering option: 

 
 
3.1 In the first field, define how the filtering conditions must be met: 

 
− None – no condition has to be met. 
− Any – Any of the filtering conditions must be met. 
− All – All of the filtering conditions must be met. 

 
3.2 In the second field, define which filtering method should be used, you 

can choose from: 
 

− Keyword - a keyword that must be in one of the columns with 
user information. 

− Status - active/inactive. 
− Roles - one of the roles described in the section "Course roles". 
− Enrolment methods - manual/standalone. 
− Groups - one of the groups created as part of the course. 
− Inactive for longer than – the definition of days since the last 

student activity in the course. 
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2.2.7 Contact With Users 
 
To send a message to a specific user, the following steps can be performed: 
 

1. Enable access to course management ("gears") 
2. In the User Link panel, select Users 
3. Select the checkbox next to the student to whom the message is to be sent 
4. At the bottom of the page, from the "With selected users" drop-down 

menu, select the "Send Message" option 
To send the message to all users, you can follow these steps: 
 

1. Enable access to course management ("gears") 
2. In the User Link panel, select Users 
3. Select all users on the list of users by checking the checkbox in front of the 

first and last name field, or using the button at the bottom of the page 
"Select all users" 

4. At the bottom of the page, from the "With selected users" drop-down 
menu, select the "Send message" option 

 
To send a message to a specific group of users, you can follow these steps: 
 

1. Enable access to course management ("gears") 
2. In the User Link panel, select Users 
3. Filter users by groups and select a specific group following the instructions 

described in the section "Filtering the list of users" 
4. Select all users on the list of users by checking the checkbox in front of the 

first and last name field, or using the button at the bottom of the page 
"Select all users" 

5. At the bottom of the page, from the "With selected users" drop-down 
menu, select the "Send message" option 

 
2.2.8 Activity Reports 
 
The course activity report is available to the administrator, course creator, teacher, 
and teacher without editing rights. As part of the overall activity report, you can see 
the number of views for each activity and the resource within the course. 
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To generate an activity report: 
 

1. Enable access to course management ("gears") 
2. In the User Link panel, select View Course Activity Reports 

 

 
 
It is also possible to generate a detailed report for each course participant. 
Information on the method of generating reports for individual users is included in 
the User Data subsection. 
 
3 Topic Management 
 
This chapter describes the basic mechanisms for managing topics within the course. 
The focus will be on creating the topic and managing its settings, as well as the 
activities and resources that can be placed inside the course. 
 
3.1 Topic Editing 
 
This section covers the basics of the topics for the courses on the platform. To add 
a new topic, please complete the following steps: 
 

1. Access to the course editing mode ("notepad") must be enabled on the 
course website 

2. At the bottom of the page, we find the "add topic" 
3. We define the number of added topics in the "Number of sections" field 

 
To edit a course, follow these steps: 
 

1. Access to the course editing mode ("notepad") must be enabled 
2. Next to the name of the course on the right, select the drop-down menu 
3. We choose one of the options: 



188 
CYBER SECURITY - TRAINING STUDENTS AND SCHOLARS FOR THE CHALLENGES OF INFORMATION 

AND COMMUNICATION TECHNOLOGIES IN RESEARCH AND STUDIES FOR INTERNATIONALISATION. 

 
− Edit topic – switch to the topic editing mode. 
− Highlight – the topic on the page is highlighted with a frame. 
− Show topic/Hide topic – setting the visibility of the topic from the 

student's point of view. 
− Delete Topic – delete the topic and all the activities created in it. 

 
As part of editing a topic, you can perform the following actions: 
 

− Post a topic - visible at the top of the section. 
− Add an abstract - the description of the topic is visible under the topic name. 
− Access limitation - you specify the activity availability only for individual 

users; you can choose from the following options: 
− Cohort - limited to a specific student cohort only.. 
− Complete an Activity - require other activities to be completed 

before access. 
− Date - you define access only at a specific time. 
− Assessment - the requirement to obtain an appropriate grade (as a 

percentage) for another activity. 
− Password - requires a password to access the resource. 
− Roles - you define access based on the user's role in the course. 
− Restriction set - you specify a set of restrictions that must be met 

before being granted access. 
 
In addition, within a specific topic, you can add activities and resources that are 
described in detail in the following subsections. 
 
3.2 Forums and Chats 
 
This section covers the basic community activities that can be added as part of the 
course. 
 
As part of social activities, the following can be distinguished: 
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− Forum - the forum you add threads and comments, both for teachers and 

students. As part of the forum entries, multimedia files can be placed. 
− Chat - This allows course participants to discuss in real time. 

 
3.2.1 Forums 
 
There are 5 types of forums within the moodle platform: 
 

− Q&A forum - Instead of initiating a discussion, participants ask a question 
in the initial discussion post. Students may respond but will not see other 
Students’ answers to a question in the discussion until they respond in the 
same discussion. 

− Standard forum for general use - an open forum where anyone can start a 
new topic at any time; this is the best general-purpose forum. 

− Everyone sends a discussion topic - each person can post exactly a new 
discussion topic (although anyone can reply to it); this is useful when you 
want each student to start a discussion on, say, their thoughts for the week, 
and everyone else to respond to them. 

− Single Discussion - A single-page discussion of one topic that is useful for 
short, focused discussions (cannot be used with separate groups). 

− Standard forum displayed like a blog. 
 

To add a forum, follow these steps: 
 

1. Access to the course editing mode ("notepad") must be enabled on the 
course website. 

2. As part of the topic in which the forum is to be placed, click on "Add activity 
or resource". 

3. In the list of activities, find a forum and then click on the activity icon. 
 
Basic settings when creating a forum: 
 

− Name - Define the name displayed on the course page. 
− Description - optional additional description of the activity displayed on the 

course website. 
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− Type - you choose one of the options described above. 
− Availability - allows you to set the availability time of the forum for students. 
− Attachments and word counting - you specify the maximum size and 

number of attachments placed within the forum and specify whether words 
should be counted within forum posts. 

− Subscription and observation - you define the method of subscribing and 
observing the forum. We can distinguish: 

− Subscription (in the case of subscribing to the forum, users receive 
an e-mail with content of any new posts on the forum): 

− Optional subscription - course participants can decide on 
their own to subscribe to the forum. 

− Force Subscription - All course participants are subscribed 
to the forum and cannot change it. 

− Automatic subscription - after creating a forum, all course 
participants are automatically assigned as subscribers to 
the forum; however, they can change it. 

− Subscription disabled - course participants cannot 
subscribe to the forum. 

− Observation (in the case of observation, participants have the 
option to see which posts on the forum they have not yet seen by 
highlighting them):  

− Optional - allow students to choose whether they want 
new messages to be highlighted. 

− Off - all new posts are automatically highlighted. 
− Blocking - you define whether forum discussions should be blocked after a 

certain period with no new entries. 
− The threshold for entries to be blocked. 
− Grading - It is possible to define the types of attendance with points, scale, 

and none, which means no attendance scores. Additionally, you can assign 
attendance grades to the appropriate grade category and define the 
attendance credit threshold. 

− Standard module options - you determine the availability (whether the 
activity should be visible to students), with an option of adding an ID 
number and a group mode in the case of many groups. 
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− Access limitation - you specify the activity availability only for individual 

users; you can choose from the following options: 
− Cohort - limited to a specific student cohort only. 
− Complete an Activity - require another activity to be completed 

before access. 
− Date - you define access only at a specific time. 
− Assessment - the requirement to obtain an appropriate grade (as a 

percentage) for another activity. 
− Password - requires a password to access the resource. 
− Roles - you define access based on the user's role in the course. 
− Restriction set - you specify a set of restrictions that must be met 

before being granted access. 
− Activity Completion - you define how you track your completion and 

expectations for an activity by a deadline. 
 
3.2.2 Chats 
 
To add a chat, follow these steps: 
 

1. Access to the course editing mode ("notepad") must be enabled on the 
course website 

2. As part of the topic in which the forum is to be placed, click on "Add activity 
or resource" 

3. In the list of activities, find a “chat” and then click on the activity icon 
 
Basic settings when creating a chat: 
 

− Name - Define the name displayed on the course page. 
− Description - optional additional description of the activity displayed on the 

course website. 
− Chat sessions - you define the following chat parameters: 

− Next chat time - you define the date of the next chat session; this 
date is automatically placed in the participant’s calendar. 
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− Repeat/publish session times - allows you to schedule new chat 

sessions automatically; there are four options to choose from: 
− do not show session times - after selecting this option, the 

exact chat hours are not set, and chat users can use it for 
the entire duration of the course. 

− do not repeat - after selecting this option, only the time of 
the next meeting will be published in the form of a chat. 

− every day at the same time - when selected, the chat is 
scheduled every day at the same time. 

− weekly at the same time - when selected, the chat is 
scheduled at the same time every week. 

− Keep past sessions - you define for how many days the chat record 
should be kept. 

− Anyone can view past sessions - you specify whether all course 
participants can view the record of past chat sessions (teachers can 
always view past sessions, this setting applies to students). 

− Standard module options - you determine the availability (whether the 
activity should be visible to students), optionally adding an id number and 
a group mode in the case of many groups. 

− Access limitation - you specify the activity availability only for individual 
users; you can choose from the following options: 

− Cohort - limited to a specific student cohort only. 
− Complete an Activity - require another activity to be completed 

before access. 
− Date - you define access only at a specific time. 
− Assessment - the requirement to obtain an appropriate grade (as a 

percentage) for another activity. 
− Password - requires a password to access the resource. 
− Roles - you define access based on the user's role in the course. 
− Restriction set - you specify a set of restrictions that must be met 

before being granted access. 
− Activity Completion - you define how you track your completion and 

expectations for an activity completion date. 
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3.3 Attendance 
 
Attendance activity allows you to keep a list of student attendance during classes. It 
allows you to set class dates, assign appropriate groups to dates, etc. 
 
To create an attendance activity, follow these steps: 
 

1. Access to the course editing mode ("notepad") must be enabled on the 
course website 

2. As part of the topic in which the forum is to be placed, click on "Add activity 
or resource" 

3. In the list of activities, find the attendance and then click on the activity icon 
 

Basic activity settings: 
 

− Name - you define the name displayed on the course page. 
− Description - optional additional description of the activity displayed on the 

course website. 
− Grade - it is possible to define attendance grades in a point, scale, and none, 

which means no attendance scores. Additionally, you can assign attendance 
grades to the appropriate grade category and define the attendance credit 
threshold. 

− Standard module options - you determine the availability (whether the 
activity should be visible to students), optionally adding an id number and 
a group mode in the case of many groups. 

− Access limitation – you specify the activity availability only for individual 
users; you can choose from the following options: 

− Cohort - limited to a specific student cohort only. 
− Complete an Activity - requires another activity to be completed 

before access. 
− Date - you define access only at a specific time. 
− Assessment - the requirement to obtain an appropriate grade (as a 

percentage) for another activity. 
− Password - requires a password to access the resource. 
− Roles - you define access based on the user's role in the course. 
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− Restriction set - you specify a set of restrictions that must be met 

before being granted access. 
− Activity Completion - you define how you track your completion and 

expectations for an activity completion date. 
 

After creating the attendance activity, you get access to the activity panel. Inside the 
panel, the following options are available on specific tabs: 
 

 
 

− Sessions - access to the view of created sessions. 
− Add session - you add a new session: 

− Session type - shared or group in case of creating groups in the 
course. 

− Session date - define the date of the meeting. 
− Time - meeting time. 
− Description - optional description. 
− Add multiple sessions - allows you to create multiple repeating 

sessions; it is especially useful for repeated activities.  
− Registration by the student - enabling the student to independently 

mark his or her presence in the tab. 
− Report - reports for visible sessions. 
− Export - allows you to export session information to a file in one of three 

formats (Excel (.xlsx), OpenOffice (.ods), text file (.txt)). 
− Status set - you define the presence statuses and the points earned for them. 

By default, four statuses are set: P - present, L - late, E - excused, and A - 
absent. In addition, you can define the time during which a particular option 
is available to the student (e.g. specifying that attendance can only be 
checked for the first 5 minutes, then the late option is available). 
Additionally, you can choose an option set by default if the student selects 
no option. 
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3.4 Activities and Resources 
 
This section describes the basic activities and resources to improve and enhance the 
quality of delivering courses for students. 
 
3.4.1 Labels, Links, and Files 
 
The section covers the basics of applying, placing, and editing labels, links, and files. 
 
3.4.1.1 Labels 
 
The label can be used to create the course structure and spacing within individual 
topics (a division of the topic into sections). As part of this course resource, the tutor 
has the option of both plain text and multimedia (images, audio/video recordings) 
and links. In particular, the job of the labels is to improve the appearance of the 
topic and separate sections. 
 
To create a label inside a topic, follow these steps: 
 

1. Access to the course editing mode ("notepad") must be enabled on the 
course website. 

2. As part of the topic in which the forum is to be placed, click on "Add activity 
or resource." 

3. In the list of activities, find the label and then click on the resource icon. 
 
Basic resource settings: 
 

− Label text - you enter the label text (text, multimedia, link) that will be 
displayed on the course page. 

− Standard module options - you determine the availability (whether the 
activity should be visible to students), optionally adding an id number and 
a group mode in the case of many groups. 

− Access limitation – you specify the activity availability only for individual 
users; you can choose from the following options: 

− Cohort - limited to a specific student cohort only. 
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− Complete an Activity - requires other activity to be completed 

before access. 
− Date - you define access only at a specific time. 
− Assessment - the requirement to obtain an appropriate grade (as a 

percentage) for another activity. 
− Password - requires a password to access the resource. 
− Roles - you define access based on the user's role in the course. 
− Restriction set - you specify a set of restrictions that must be met 

before being granted access. 
 

3.4.1.2 Links 
 
The URL may be used as part of the course to provide course participants with a 
link to external resources that cannot be included in the course. 
 
To add a link inside a topic, follow these steps: 
 

1. Access to the course editing mode ("notepad") must be enabled on the 
course website. 

2. Under the topic where the link is to be placed, click on "Add activity or 
resource." 

3. In the list of activities, find the URL address and click on the resource icon. 
 
Basic resource settings: 
 

− Name - link name, text visible to course participants. 
− External URL - www address to which the link should be redirected. 
− Description - description of the link visible to course participants. 
− Appearance - you define how the reference page should be displayed; there 

are four options: 
− Automatically. 
− Embedded - the referenced website is embedded within the 

Moodle platform, leaving the course header and blocks. 
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− Open - you are directly redirected to the website within the current 

browser tab. 
− In the pop-up window – the website opens within a new browser 

window. 
− Changing the URL address - transfers internal information from moodle 

course such as course data (id, course name, etc.), and user data (id, first 
name, e-mail, etc.) to the URL. 

−  Standard module options - you determine the availability (whether the 
activity should be visible to students), optionally adding an id number and 
a group mode in the case of many groups. 

− Access limitation - you specify the activity availability only for individual 
users; you can choose from the following options: 

− Cohort - limited to a specific student cohort only. 
− Complete an Activity - requires another activity to be completed 

before access. 
− Date - you define access only at a specific time. 
− Assessment - the requirement to obtain an appropriate grade (as a 

percentage) for another activity. 
− Password - requires a password to access the resource. 
− Roles - you define access based on the user's role in the course. 
− Restriction set - you specify a set of restrictions that must be met 

before being granted access. 
− Activity Completion - you define how you track your completion and 

expectations for an activity completion date. 
 
3.4.1.3 Files 
 
It allows you to upload files with any extension within the Moodle platform and 
place them in the course. 
 
To add a file inside a topic, follow these steps: 

1. Access to the course editing mode ("notepad") must be enabled on the 
course website. 
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2. Under the topic where the file is to be placed, click on "Add activity or 

resource." 
3. In the list of activities, find the file and click on the resource icon. 

 
Basic resource settings: 
 

− Name - the name of the file, visible to course participants. 
− Description - files description visible to course participants. 
− Select file - sends a file through the activity window or in the form of drag 

and drop. 
− Appearance - you specify how the file should be displayed on the course 

page, and additionally allows you to display the file size, type, and date of 
transfer; there are four options to choose from: 

− Automatically. 
− Embedded - the file is embedded within the Moodle platform, 

leaving the course header and blocks behind. 
− Force download - opens a file, it must be downloaded by the user. 
− Open - the file is opened under the current tab. 
− In a pop-up window - the file is opened in a new browser window. 

− Standard module options - you determine the availability (whether the 
activity should be visible to students), optionally adding an id number and 
a group mode in the case of many groups. 

− Access limitation - you specify the activity availability only for individual 
users; you can choose from the following options: 

− Cohort - limited to a specific student cohort only. 
− Complete an Activity - requires another activity to be completed 

before access. 
− Date - you define access only at a specific time. 
− Assessment - the requirement to obtain an appropriate grade (as a 

percentage) for another activity. 
− Password - requires a password to access the resource. 
− Roles - you define access based on the user's role in the course. 
− Restriction set - you specify a set of restrictions that must be met 

before being granted access. 
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− Activity Completion - you define how you track your completion and 

expectations for an activity completion date 
 
3.4.2 Folders 
 
The folder allows the teacher to add a directory in which he or she can then put files. 
A folder is useful if you need to transfer a large number of files or need to group 
them together. 
 
To add a folder to a topic, follow these steps: 
 

1. Access to the course editing mode ("notepad") must be enabled on the 
course website. 

2. Under the topic in which the folder is to be placed, click on "Add activity 
or resource." 

3. In the list of activities, find a folder and then click on the resource icon. 
 
Basic resource settings: 
 

− Name - the name of the file, visible to course participants. 
− Description - file description visible to course participants. 
− Content - allows you to upload files to the directory: 

− Files - allows you to transfer files to a directory; files can be 
uploaded independently or in the form of a single .zip file which 
can later be unpacked. 

− Display folder contents - allows you to set the way of displaying the 
folder contents. You can choose to display the contents on a new 
page or the course's main page. Additionally, you can select options 
such as show directory structure, show download folder button, 
and force download files. 

− Standard module options - you determine the availability (whether the 
activity should be visible to students), optionally adding an id number and 
a group mode in the case of many groups. 

− Access limitation - you specify the activity availability only for individual 
users; you can choose from the following options: 
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− Cohort - limited to a specific student cohort only. 
− Complete an Activity - requires another activity to be completed 

before access. 
− Date - you define access only at a specific time. 
− Assessment - the requirement to obtain an appropriate grade (as a 

percentage) for another activity. 
− Password - requires a password to access the resource. 
− Roles - you define access based on the user's role in the course. 
− Restriction set - you specify a set of restrictions that must be met 

before being granted access. 
− Activity Completion - you define how you track your completion and 

expectations for an activity completion date. 
 

3.4.3 Tasks 
 
The task allows the teacher to collect students' work, evaluate them and comment 
on them. It is a very useful activity in which students can submit their works in the 
form of files of any type and a collection of files in a compressed format (e.g., zip, 
rar). The teacher can leave a comment or upload files as part of the answer. 
 
To add a task inside a topic, follow these steps: 
 

1. On the course website, you must enable access to the course editing mode 
("notepad"). 

2. Under the topic where the task is to be placed, click "Add activity or 
resource." 

3. In the list of activities, find a task and click on the resource icon. 
 
Basic resource settings: 
 

− Name - the name of the folder, visible to course participants. 
− Description - description of the folder visible to course participants. 
− Additional files - additional files visible to the course participants, e.g. the 

content of the task in the form of a pdf file. 
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− Availability - you determine the availability of the task for course 

participants: 
− Allow task submission from - you define the date from which 

students can submit their task solutions. 
− Deadline for submission - the deadline by which students must 

send their solutions to the tasks. If the task allows submission of 
work after this date, the task will be defined as late. 

− Deadline - the date after which students cannot submit solutions. 
− Remind me to evaluate - this is the date visible to the teacher in the 

cockpit and calendar, reminding me to check the solutions sent by 
the course participants. 

− Types of tasks 
− Types of tasks - you define the form of submitting tasks; there are 

two options to choose from: 
− Online text and recording - students can post solutions 

using the HTML editor. 
− Word limit - defining the maximum number of 

words the student can send as part of the solution. 
− Uploaded files - students can upload solutions as uploaded 

files: 
− Maximum number of transferred files - you 

determine the maximum number of files that can 
be transferred by the student in the form of a 
solution. 

− Maximum size of the transferred file - the 
maximum size that the student can send the 
solution. 

− Accepted file types - you define what types of files 
can be sent by the student as part of solving the 
task. 

− Types of feedback - you determine the form of the feedback given to the 
student by the teacher; four types can be distinguished: 

− Feedback - sends a feedback comment to the task posted by the 
student. 
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− PDF Annotation - allows PDF solutions to display them and add 

notes, drawings, and comments directly on the student's work. 
− Off-line evaluation sheet - enables the teacher to download and 

send a sheet with student grades. 
− Comments files - enables the teacher to send files with comments 

to the students. 
− Group task settings - assigns a task to a specific group of students. 
− Content - allows you to send files to the directory: 

− Files - sends files to a directory; files can be uploaded independently 
or in the form of one .zip file, which can later be unpacked. 

− Display folder contents - sets the method of displaying the folder 
contents; you can choose to display the contents on a new page or 
the course’s main page. Additionally, you can select options such 
as show directory structure, show download folder button, and 
force download files. 

− Standard module options - you determine the availability (whether the 
activity should be visible to students), optionally adding an id number and 
a group mode in the case of many groups. 

− Access limitation - you specify the activity availability only for individual 
users; you can choose from the following options: 

− Cohort - limited to a specific student cohort only. 
− Complete an Activity - requires another activity to be completed 

before access. 
− Date - you define access only at a specific time. 
− Assessment - the requirement to obtain an appropriate grade (as a 

percentage) for another activity. 
− Password - requires a password to access the resource. 
− Roles - you define access based on the user's role in the course. 
− Restriction set - you specify a set of restrictions that must be met 

before being granted access. 
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3.4.4 Virtual Programming Lab 
 
The Virtual Programming Lab (VPL) enables the teacher to collect programming 
work in many programming languages and present students' work in real time. This 
activity makes it possible to create programmes in almost any programming 
language, save a copy of the created programme and its compilation, debugging, and 
observing the results obtained. 
 
To add a VPL inside a topic, follow these steps: 
 

1. On the course website, you must enable access to the course editing mode 
("notepad"). 

2. Under the topic in which the task is to be placed, click on "Add activity or 
resource." 

3. In the list of activities, find the Virtual Programming Lab and then click on 
the resource icon. 

 
Basic activity settings: 
 

− Name - the name of the VPL, visible to course participants. 
− Short description - short information about the VPL visible to participants. 
− Description - description of the VPL visible to course participants. 
− Work submission period - specify the period during which the activity will 

be available to course participants. 
− Available from - you specify the date after which the activity will be available 

to course participants. 
− End date - you specify the date after which the activity will cease to be 

available to course participants, which results in the impossibility of further 
editing the submitted works or sending new works. 

− Restrictions on submitting works - you define restrictions on submitting 
works. 

− Maximum number of files - the maximum number of files (programmes) 
that a course participant can upload or create. 

− Uploading an external file, paste and drop external content - you specify 
whether a course participant should be able to upload a ready file with the 
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programme and also be able to copy content from an external file to a 
created file inside the VPL. 

− Maximum file upload size - you define the maximum length of a course sent 
by a course participant. 

− Password - sets a VPL access password that the course participant must 
provide to be able to use the activity. 

− Standard module options - you determine the availability (whether the 
activity should be visible to students), optionally adding an id number and 
a group mode in the case of many groups. 

− Access limitation - you specify the activity availability only for individual 
users; you can choose from the following options: 

o Cohort - limited to a specific student cohort only. 
o Complete an Activity - requires another activity to be completed 

before access. 
o Date - you define access only at a specific time. 
o Assessment - the requirement to obtain an appropriate grade (as a 

percentage) for another activity. 
o Password - requires a password to access the resource. 
o Roles - you define access based on the user's role in the course. 
o Restriction set - you specify a set of restrictions that must be met 

before being granted access. 
 
3.4.4.1 Compiler Settings 
 
Another important element is setting up the compiler and making it possible to 
compile, debug and run the programme. To do this, after creating a VPL activity, 
follow these steps: 
 

1. On the course page, in the selected topic, click on the name of the added 
VPL. 

2. On the right side, select the option to edit the activity (gear). 
3. Choose "Execution options." 
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Within the execution option, you can set the following option: 
 

− Run script - you specify the compiler of the selected programming language; 
if you choose the automatic detection option, the compiler compatible with 
the extension of the transferred file will be chosen. 

− Debug script - you specify the debugging language; if you select the 
automatic detection option, the compiler compatible with the extension of 
the transferred file will be chosen. 

− Run - you define whether the course participant should be able to run his 
or her programme inside the VPL. 

− Debug - you specify if the participant should be able to debug his or her 
programme inside the VPL. 

− Automatic evaluation - specify whether the programme should be 
automatically checked based on test data. 

 
3.4.4.2 Basic Information About a VPL Activity Created 
 
After clicking on the name of the created activity on the course page, you will see a 
page with four tabs: Task description, Submitted papers, Code similarity check, and 
Test component. 
 

 
 
Task description - this is the first tab devoted to the description of the task; in it, 
you can find a detailed description of the activity, the date of the end of the activity, 
the maximum number of files to be sent set by the teacher, information about 
whether the work is performed individually or in groups, the issue of setting grades. 
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In addition, information is included on whether the submitted code is subject to 
evaluation by the lecturer and whether the code written by the student can be 
debugged and run in VPL by the student. 
 
Submitted works - under the 'Composed Works' tab, the teacher has access to all 
submitted works sent by course participants. The student's name and surname, 
information about the date of sending the document, the last version of the 
programme, the number of saved programmes (earlier copies of the code), and a 
gear wheel are displayed. After clicking on the gear wheel icon, you gain access to 
additional options, such as a preview of the submitted work, a list of submitted 
components, options, and the possibility of making a copy. 
 
 
Checking the similarities in the code allows for analysing the similarities between the 
programmes sent by the course participants. It allows you to check the similarity to 
other submitted programmes, as well as to the solution sent by the teacher. 
 

 
 
Test components - allows you to manage test components 
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3.4.4.3 Preview of the Submitted Work  
 
As part of the submitted works, you can see a list of submitted components , an 
incremental graph of the size of the submitted files, and a graph of working time 
and activity within the task. 
 

 
 

 
 
After selecting any programme instance, the entire submitted programme is visible. 
 

 
 
Additionally, an edit option can be chosen that makes changes in the code, runs it, 
debugs it, and performs tests at the evaluation level by the test examples created. 
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3.4.4.4 Preparation of Test Files and Check Programme 
 
As part of the programme implementation, you can prepare test files to analyse the 
solution. You can create a test file by selecting the task settings (gear) and selecting 
test cases. 
 
When creating a test case, its name should be given after the keyword "case", e.g., 
case = one 
 
Then provide the input data that will be assigned to the values entered from the 
keyboard, e.g. (the two numbers to be added are entered, separated by an “enter” 
key - number 5 and number 6) 
Input = 5 
 
The next task is to pass the result of the operation after the keyword "output", e.g. 
Output = 11 
 
Sample test file (Test Cases): 
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3.4.5 Jupyter Notebook 
 
Jupyter Notebook is an open-source web application. It allows the creation and 
sharing of documents with live code, various equations, visualisations, etc. Among 
the users of Jupyter Notebook, we can distinguish between numerical simulations, 
statistical modelling, machine learning, etc. 
 
It is most often used as an application to create programmes in Python language and 
then analyze them. As part of Moodle, an instance of a virtual machine is created for 
each student, on which the student can create files. When creating a programme, the 
teacher does not have access to the created programme, so a good solution is to 
allow the student to upload the finished programme using a different activity. 
 
After the end of the lesson, the programme is still available to the student for the 
time established by the administrators of the Moodle platform. The time of 
availability is defined as the time since the last launch of the programme by the 
student. 
 
As part of the course, the teacher can add the Jupyter Notebook activity in the 
following way: 
 

1. On the course website, you must enable access to the course editing mode 
("notepad"). 

2. Under the topic in which the task is to be placed, click on "Add activity or 
resource." 
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3. In the list of activities, find the Jupyter Notebook and then click on the 

resource icon. 
 

 
 
After clicking on the activity, the student can start his Notebook. 
 

 
Then a virtual machine is created for the student to operate the Jupyter Notebook. 
 

 
 
Once created, the student has the option to create their programme. 
 

 
 
4 Assessing Students 
 
This section describes the basic type of quiz designed for the examination and 
assessment of students. 
  
4.1 Quiz 
 
In this subsection, we present the basic test quiz.  
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4.1.1 Test Quiz 
 
The Quiz test is an online real-time test in which the student has the opportunity to 
answer questions at the time specified by the teacher, which can then be checked 
automatically or manually by the teacher (depending on the type of questions 
described in the section questions types). 
 
To create a Test Quiz activity, follow these steps: 
 

1. Access to the course editing mode ("notepad") must be enabled on the 
course website. 

2. As part of the topic in which the test quiz is to be placed, click on "Add 
activity or resource." 

3. In the list of activities, find the test quiz and click on the activity icon. 
 
Basic resource settings: 
 

− Name - the name of the folder, visible to course participants. 
− Description - description of the folder visible to course participants. 
− Time - you define the date (day, hour) when the test will be available and its 

duration: 
− Open the test - the date on which the test becomes available to 

students (it is possible to start the test); if it is not enabled, the test 
is available continuously. 

− Close the test - you specify the date (day, time) on which the test is 
no longer available to students. They cannot start the test. If it is 
not enabled, the test is available continuously after opening. 

− Time limit - the time during which the student can write the test, 
starting from the moment the student starts the test. 

− After the time expires – it allows the supervisor to decide how the 
test should behave after the end of the test; you can choose one of 
three options: 

− Open approaches are saved automatically - after 
completing the test (timeout), the student's open approach 
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is closed, and the answers given so far are saved and 
transferred for evaluation. 

− Existing grace period - you specify the time that begins 
after exceeding the time limit and allows the student to 
review and approve their answers. Still, the student cannot 
answer new questions. 

− Attempts must be approved before the end of time - when 
selected, approaches that are not completed by the student 
and approved before the end of time are not validated. 

− Assessment - you define the method of assessment. 
− Assessment category - if you create a grade category, you can assign 

to which category the grade for the quiz should be assigned. 
− Passing threshold - you define the threshold at which the test is 

passed; it is used, among other functions, in the grading log, where 
quizzes taken are marked in green and failed quizzes in red. 

− Available approaches - you define how many times the student is 
allowed to take the quiz. 

−  Assessment method - if you select that the student can take the 
quiz more than once, it allows you to specify how the quiz grade 
should be determined; there are several options to choose from: 

− Top grade. 
− Average grade. 
− The first attempt. 
− The last attempt. 

− Layout - you define basic information about the layout of the test view and 
how to view it: 

− Number of questions per page - divides the test into pages, and you 
determine how many questions should be visible on a single page; 
this is useful for long tests. 

− Navigation method - you define the way the student can view the 
quiz; there are two options to choose from: 

− Any - the student can freely navigate through the test, and 
move to the next and previous questions. 
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− Sequential - after answering the question, the student 

cannot return to it to change the answer. 
− Questions Behavior - you specify how questions should be displayed and 

how questions should behave after answering: 
− Change the order inside the question - in the case of multiple-

choice questions, it allows you to change the order of answers for 
each student taking the quiz. 

− How the questions behave - you define the behaviour of questions 
after the student answers or during the answer; there are several 
options to choose from: 

− Feedback after completion of the CBM approach. 
− Interactive with repetitions - if this option is selected, 

student see that they made a mistake immediately after 
answering and then has the option of correcting it, which, 
however, results in receiving a smaller number of points 
for the answer. 

− Immediate feedback - the student immediately after 
answering can see if the answer was correct. 

− Instant feedback from CBM. 
− Manual grading. 
− Delayed feedback - students answer questions, and only 

after all answers have been approved, they receive a grade 
and comment. 

− Adaptive mode. 
− Adaptive mode (no penalty). 

− Review options - change the view for the student during and after the quiz, 
depending largely on the chosen behaviour of the questions and the 
inclusion of the duration. 

− You can specify the following options: 
− While testing (only available for interactive and immediate 

feedback modes) – it can be viewed while writing the test. 
− Immediately after the test - it can be viewed immediately 

after the end of the test (approx. 2 minutes). 
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− Later, while the test is still open - it can be viewed as long 

as the test is open. 
− After closing the test - when the time has elapsed during 

which the test is available for all students to solve. 
− The following items can be specified for each option: 

− Rehearsal - you specify whether the student can see his or 
her approach to the quiz. 

− Is correct – you display information to the student about 
the answer given by him or her as 'Correct', 'Partially 
correct' or 'Incorrect'. 

− Points - information about the number of points obtained 
for a specific task and the total number of points obtained 
for the entire quiz. 

− Detailed feedback - information prepared by the lecturer, 
which is displayed after the student has answered. 

− Standard module options - you determine the availability (whether the 
activity should be visible to students), optionally adding an id number and 
a group mode in the case of many groups. 

− Access limitation - you specify the activity availability only for individual 
users; you can choose from the following options: 

− Cohort - limited to a specific student cohort only. 
− Complete an Activity - requires another activity to be completed 

before access. 
− Date - you define access only at a specific time. 
− Assessment - the requirement to obtain an appropriate grade (as a 

percentage) for another activity. 
− Password - requires a password to access the resource. 
− Roles - you define access based on the user's role in the course. 
− Restriction set - you specify a set of restrictions that must be met 

before being granted access. 
 
After creating a quiz, it is possible to fill it in with previously prepared questions or 
to create new questions. 
 



M. Głąbowski, J. Grzelski, K. Śniatała Paweł Śniatała, M. Weissenberg:  
Moodle Basics – A User Guide 215. 

 
To add questions to the quiz, follow these steps: 
 

1. On the course page, find the quiz activity you added. 
2. Enter the chosen quiz by clicking on its name. 
3. On the right side of the quiz window, find a gear icon and click on it (it is 

not the same gear as for the course management). 
4. Select the option "Edit test content" from the drop-down list. 

 
4.2 Question Database 
 
4.2.1 Categories 
 
This section describes the basics of creating categories and adding questions to 
categories. Categories are treated as directories into which questions can then be 
placed. They also allow you to create a hierarchical structure. The use of categories 
is considered good practice and allows you to break down the questions you create 
into some linked structures of a similar nature, which is great for creating random 
question quizzes.  
 
To create a category, follow these steps: 
 

1. Enable access to course management ("gears"). 
2. On the Question Bank page, select the Question Category. 
3. At the bottom of the page, there is a button for adding a new category. 
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The most important element is to define the parent category in which the new 
category will be placed, then the name of the category and optional information 
about the category should be provided. Once created, it can also be moved 
elsewhere, modified, or deleted. 
 

 
 
4.3 Question Types 
 
This section describes the basic question types that can be created within the course 
and the general way to add questions. To add a new question, follow these steps: 
 

1. Enable access to course management ("gears") 
2. In the Question bank panel, select Question database 
3. Specify the category to which the question should be added 

 

 
 
4.3.1 Drag and Drop 
 
Question type where missing words in the text are filled with labels by drag and 
drop. When creating a question, the number of the label you want to place in the 
right place is specified in double square brackets.  
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Basic question settings: 
 

− Current category - the current category in which the option to add a 
question has been selected, the question will be added to it. 

− Save in category - in case of resignation from the current category, you can 
select the category in which the question should be located from the drop-
down menu. 

− Question name - the name displayed on the list of questions, helping to 
identify the question (but it is not visible to students). 

− Content of the question - the content of the question intended for students: 
 

.  
 

− Default score - the default number of points to be obtained for the question 
(may be scaled when creating a test for students). 

− General feedback - information is displayed to students after answering a 
question. 

− ID - optional ID of the question must be unique. 
− Choices - define the labels that can be added: 

− Random - selecting this option changes the order in which the 
labels are displayed randomly. 

− Choice [[n]] - where "n" is a number, which is the identifier to be 
entered in the text of the question as to the correct answer (to 
increase the pedagogic level of difficulty for students, you can add 
more labels than there are correct answers). 

− Answer - the content of the label. 
− Group - you define the label group (they differ in colours when 

displaying the question), e.g. 
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− Complex feedback - you add additional information for the student to be 
displayed after answering: 

− For each correct answer - information is displayed if a correct 
answer is given. 

− For each partially correct answer – information is displayed when 
a partially correct answer is given. 

− Multi-trial settings - necessary settings if the student is allowed to approach 
a question multiple times: 

− Penalty for each incorrect answer - reduction is expressed as a 
percentage of the possible points in the case of an incorrect answer. 

− Tip - advice aimed at helping the student. 
−  Hint options - you clear only incorrect answers and display the 

number of correct answers to the student. 
− Save changes - after pressing the save changes button, the question is added 

to the selected category. 
 
View of an example question created based on the above description: 
 

 
 
4.3.2 Essay 
 
Question type that allows the student to answer by sending a file or filling in the 
editor field. Essay-type tasks must be manually graded by the tutor. 
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Basic question settings: 
 

− Category - you select the category in which the question should be placed 
from the drop-down menu. 

− Name of the question - the name is visible on the list of questions to help 
identify the question (but it is not visible to students). 

− Content of the question - the content of the task is visible to students. 
− Default score - the default number of points to be obtained for the question 

(it can be scaled when creating a test for students). 
− General feedback - information is displayed to students after answering a 

question. 
− ID - optional ID of the question must be unique. 
− Response options - basic response options, we can distinguish: 

− Response format - you define the format of the response field for 
the student: 

− HTML editor - the editor field allows you to type using an 
HTML editor, insert links, images, equation editor, etc. 

− HTML editor with file selection - additionally allows you 
to insert audio/video recordings, word templates, etc. 

− Plain Text - Only keyboard text can be entered. 
− Required text - you specify whether the text field must contain 

content for the question to be sent. 
− Input field size - you define the number of lines of text visible to 

the student. 
− Allow attachments - allows students to upload files with solutions. 

− Response template - you enter a template that is visible to the student and 
allows you to standardise the answers or indicate the form of the answer. 
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− Save changes - after pressing the save changes button, the question is added 

to the selected category. 
 

 
 
4.3.3 Matching 
 
Question type in which the content area and the list of names (possible to choose, 
displayed in the form of a drop-down menu) must be appropriately matched to the 
content. 
 
Basic question settings: 
 

− Category - you select the category in which the question should be placed 
from the drop-down menu. 

− Name of the question - the name is visible on the list of questions, helping 
to identify the question (but it is not visible to students).  

− Content of the question - the content of the task is visible to students. 
− Default score - the default number of points to be obtained for the question 

(it can be scaled when creating a test for students). 
− General feedback - information is displayed to students after answering a 

question. 
− ID - optional ID of the question must be unique. 
− Answers - you enter questions and answers. It is necessary to provide at 

least two questions (content area) and three answers (name list). To add 
additional incorrect answers, leave the question field blank. 
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− Complex feedback - you add additional information for the student to be 
displayed after answering: 

− For each correct answer - information is displayed if a correct 
answer is given. 

− For each partially correct answer - information is displayed when a 
partially correct answer is given. 

− Multi-trial settings - necessary settings to allow the student to approach a 
question repeatedly: 

− Penalty for each incorrect answer - reduction is expressed as a 
percentage of possible points in the case of an incorrect answer. 

− Tip - advice aimed at helping the student. 
− Hint options - you clear only incorrect answers and display the 

number of correct answers to the student. 
− Save changes - after pressing the save changes button, the question is added 

to the selected category 
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4.3.4 Matching by Drag and Drop 
 
The question type in which the content area appears and the list of names (you can 
see them on the right side of the question) that must be appropriately matched to 
the content. 
 
Basic question settings: 
 

− Category - you select the category in which the question should be placed 
from the drop-down menu. 

− Name of the question - the name is visible on the list of questions; it helps 
identify the question (but it is not visible to students). 

− Content of the question - the content of the task is visible to students. 
− Default score - the default number of points to be obtained for the question 

(it can be scaled when creating a test for students). 
− General feedback - information is displayed to students after answering a 

question. 
− ID - optional ID of the question must be unique. 
− Answers - you enter questions and answers. It is necessary to provide at 

least two questions (content area) and three answers (name list). To add 
additional incorrect answers, leave the question field blank. 

− Complex feedback - you add additional information for the student to be 
displayed after answering: 

− For each correct answer - information is displayed if a correct 
answer is given. 

− For each partially correct answer - information is displayed when a 
partially correct answer is given. 

− Multi-trial settings - necessary settings to allow the student to approach a 
question repeatedly: 

− Penalty for each incorrect answer - reduction is expressed as a 
percentage of possible points in the case of an incorrect answer. 

− Tip - advice aimed at helping the student. 
− Hint options - you clear only incorrect answers and display the 

number of correct answers to the student. 
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− Save changes - after pressing the save changes button, the question is added 

to the selected category 
 

 
 
4.3.5 Multiple Choice 
 
Question type that allows you to create a selection task with one or more correct 
answers.  
 
Basic question settings: 
 

− Category - you select the category in which the question should be placed 
from the drop-down menu. 

− Name of the question - the name is visible on the list of questions, helping 
to identify the question (but it is not visible to students). 

− Content of the question - the content of the task is visible to students. 
− Default score - the default number of points to be obtained for the question 

(it can be scaled when creating a test for students) 
− General feedback - information is displayed to students after answering a 

question. 
− ID - optional ID of the question must be unique. 
− Shuffle answers -  selecting this option causes the random selection of 

answers on the list of answers. 
− One or more answers? - select from the drop-down menu whether the 

question contains one correct answer or many correct answers. 
− Numbering of responses - you choose the method of numbering the 

answers. 
− Show standard instructions - you choose whether an instruction for 

answering should appear before the question, e.g., "select one answer", or 
"select all correct answers". 
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− Responses - you enter the answers and score them accordingly: 

− When selecting: Only one answer: 
− One of the answers should be given 100%. 
− If the other answers are chosen to mark none, 0 points are 

given for the incorrect answer. 
− If you choose negative values for the remaining answers if 

you choose a wrong answer, negative points are given by 
the percentage. 

− When selecting: More than one answer: 
− The sum of points for correct answers must be 100%. 
− If the remaining answers are chosen, no points are 

deducted, and no points are deducted for incorrect 
answers, so the student, by selecting all answers, gets 100% 
of the points. 

− If you choose negative points for the remaining answers, 
they are subtracted from the maximum number of points; 
choosing - 100% resets   the result when selecting the 
correct and incorrect answer. 

− It is impossible to set receiving points only if you select all 
correct answers; for this, you can use the task: All or 
nothing. 

− Complex feedback - you add additional information for the student to be 
displayed after answering: 

− For each correct answer - information is displayed if a correct 
answer is given. 

− For each partially correct answer - information is displayed when a 
partially correct answer is given. 

− Multi-trial settings - necessary settings if the student is allowed to approach 
a question multiple times: 

− Penalty for each incorrect answer  -  reduction is expressed as a 
percentage of the possible points in the case of an incorrect answer. 

− Tip - advice aimed at helping the student. 
− Hint options - you clear only incorrect answers and display the 

number of correct answers from the students. 
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− Save changes - after pressing the save changes button, the question is added 

to the selected category. 
 

 
 

4.3.6 All or Nothing Multiple Choice 
 
A question type that creates a selection task with one or more correct answers, giving 
100% if you selected all correct answers or 0% if you selected any incorrect answers 
or did not select all correct answers. 
 
Basic question settings: 
 

− Category - you select the category in which the question should be placed 
from the drop-down menu. 

− Name of the question - the name is visible on the list of questions, helping 
to identify the question (but it is not visible to students). 

− Content of the question - the content of the task is visible to students. 
− Default score - the default number of points to be obtained for the question 

(it can be scaled when creating a test for students). 
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− General feedback - information is displayed to students after answering a 

question. 
− ID - optional ID of the question; it must be unique. 
− Shuffle answers -  selecting this option causes the random selection of 

answers on the list of answers. 
− One or more answers - you select from the drop-down menu whether the 

question contains one correct answer or many correct answers. 
− Numbering of responses - you choose the method of numbering the 

answers, e.g. A, B, C or 1, 2, 3, etc. 
− Responses – you enter answers and information on whether the answer is 

correct or not. To receive points, the student must select all answers marked 
as correct. 

− Complex feedback - you add additional information for the student to be 
displayed after answering: 

− For each correct answer - information is displayed if a correct 
answer is given. 

− For each partially correct answer - information is displayed when a 
partially correct answer is given. 

− Multi-trial settings - necessary settings if the student is allowed to approach 
a question multiple times 

− Penalty for each incorrect answer  -  reduction is expressed as a 
percentage of the possible points in the case of an incorrect answer. 

− Tip - advice aimed at helping the student. 
− Hint options - you clear only incorrect answers and display the 

number of correct answers from the students. 
− Save changes - after pressing the save changes button, the question is added 

to the selected category. 
 

4.3.7 Short answer 
 
A question type that allows the student to enter a short answer of several words, 
which is then compared to the entered patterns. 
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Basic question settings: 
 

− Category - you select the category in which the question should be placed 
from the drop-down menu. 

− Name of the question - the name is visible on the list of questions, helping 
to identify the question (but it is not visible to students). 

− Content of the question - the content of the task is visible to students. 
− Default score - the default number of points to be obtained for the question 

(it can be scaled when creating a test for students). 
− General feedback - information is displayed to students after answering a 

question. 
− ID - optional ID of the question, must be unique. 
− Case-sensitive – you define whether the student's entered letters are case 

sensitive. 
− Answers - you enter the answers (answer patterns) and the appropriate 

number of points due to them. The symbol "*" stands for any character 
− Complex feedback - you add additional information for the student to be 

displayed after answering 
− For each correct answer - information is displayed if a correct 

answer is given. 
− For each partially correct answer - information is displayed when a 

partially correct answer is given. 
− Multi-trial settings - necessary settings if the student is allowed to approach 

a question multiple times: 
− Penalty for each incorrect answer  -  reduction is expressed as a 

percentage of the possible points in the case of an incorrect answer. 
− Tip - advice aimed at helping the student. 
− Hint options - you clear only incorrect answers and display the 

number of correct answers from the students. 
− Save changes - after pressing the save changes button, the question is added 

to the selected category. 
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4.3.8 Numerical 
 
Question type that allows you to enter a numerical answer that is checked by 
comparing it with the pattern introduced by the teacher, taking into account the 
tolerance (e.g. rounding off). 
 
Basic question settings: 
 

− Category - you select the category in which the question should be placed 
from the drop-down menu. 

− Name of the question - the name is visible on the list of questions, helping 
to identify the question (but it is not visible to students). 

− Content of the question - the content of the task is visible to students. 
− Default score - the default number of points to be obtained for the question 

(it can be scaled when creating a test for students). 
− General feedback - information is displayed to students after answering a 

question. 
− ID - optional ID of the question, must be unique. 
− Case-sensitive - you define whether the student's entered letters are case 

sensitive. 
− Responses - you enter answers in numerical form, including an acceptable 

error and a grade for a given answer. 
− Unit related settings - you enter units as an element of evaluation: 

− Unit related settings - three options can be selected, units are not 
used, the unit is optional or necessary. 

− Decreasing the grade for error in the unit - in the case of selecting 
the option that the unit is necessary, it is possible to designate in 
the range (0-1) for how many percent of points are subtracted for 
the wrong unit. 

− Unit entered via - you define how the unit should be entered. There 
are three options to choose from, a text box, a button, and a drop-
down list. 

− The unit stands up - you specify whether a unit should appear 
before or after a numerical value. 
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− Units - you enter the correct unit. 
− Multi-trial settings - necessary settings if the student is can answer a question 

multiple times. 
− Penalty for each incorrect answer  -  reduction is expressed as a 

percentage of the possible points in the case of an incorrect answer. 
− Tip - advice aimed at helping the student. 
− Hint options - you clear only incorrect answers and display the 

number of correct answers from the students. 
− Save changes - after pressing the save changes button, the question is added 

to the selected category. 
  

4.3.9 True/False 
 
True / False question type. 
 
Basic question settings: 
 

− Category - you select the category in which the question should be placed 
from the drop-down menu. 

− Name of the question - the name is visible on the list of questions, helping 
to identify the question (but it is not visible to students). 

− Content of the question - the content of the task is visible to students. 
− Default score - the default number of points to be obtained for the question 

(it can be scaled when creating a test for students). 
− General feedback - information is displayed to students after answering a 

question. 
− ID - optional ID of the question, must be unique. 
− Correct answer – you determine whether the correct answer is marked true 

or false by the student. 
− Multi-trial settings - necessary settings if the student is allowed to approach 

a question multiple times: 
− Penalty for each incorrect answer - reduction is expressed as a 

percentage of the possible points in the case of an incorrect answer. 
− Tip - advice aimed at helping the student. 
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− Hint options - you clear only incorrect answers and display the 

number of correct answers from the students. 
−  Save changes - after pressing the save changes button, the question is added 

to the selected category. 
 
4.4 Import Questions 
 
This section describes how to import course questions from a previously created 
file. 
 
To import questions to the course, follow these steps: 

1. Enable access to course management ("gears") 
2. In the Question bank pane, select Import 
3. Select the format of the question file you want to import 
4. Select the main category to which the questions should be imported 
5. Determine what the system should do when an error occurs 
6. Placing the question file via the activity window or drag and drop the file 
7. Click on the import button 

  
4.5 Export Questions 
 
This section describes how to export questions from a course to a file that you can 
use to import in another course in the future. In Moodle, you can export questions 
to several basic formats, detailed in Formats and Examples of files with questions. 
In the case of questions with an attached multimedia file, it is recommended to use 
the Moodle XML file. 
 
To export course questions to a file, follow these steps: 
 

1. Enable access to course management ("gears") 
2. In the Question bank panel, select Export 
3. Select the format of the question file to which you want to export 
4. Select the main category from which the export is to be performed 

(subcategories of the selected category are automatically included) 
5. Click on the Export questions to file button 
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5 Backup and Restore 
 
This chapter describes how to backup a created course and how to restore a course 
from a created template with data. 
 
5.1 Backup 
 
This section describes how to back up your course. The teacher within his or her 
course has the option to back up selected parts of the course, which can be used to 
maintain the history of the course being conducted or to create a new course using 
the topics and data included in the current course. This copy can be generated and 
saved to disk in an offline form. 
 
To create a backup file of your course, follow these steps: 

1. Enable access to course management ("gears") 
2. In the Course Settings pane, select Backup 
3. Select Backup settings, which allow you to define what the backup should 

contain. The most important elements include: including course users, 
activities, resources, blocks, files, question bank, and groups 

4. Select the scheme settings and include the individual activities within the 
copy 

5. At the bottom of the page, click on the backup button 
 
5.2 Course Restoring 
 
This section describes how to restore your course from a backup. The previously 
created backup file in the .mbz format allows you to restore the course together with 
the data contained in the backup. 
 
To restore a course from a backup, follow these steps: 
 

1. Enable access to course management ("gears" 
2. In the Course Settings pane, select Restore 
3. Select the file to import through the activity field or by drag and drop 
4. At the bottom of the page, click on Restore 
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Conclusions 
 
The developed document is based on an analysis of websites and the authors' own 
experience. The main document that contributed to the development of the 
handbook was the Moodle documentation available at www: 
https://docs.moodle.org. The Moodle documentation provides fully detailed 
descriptions of all components, but due to its universal nature does not correspond 
100% to the template used in the project.  
 
In the future, the authors of the user guide will introduce additional information on 
the new features implemented in Moodle and added to the platform used and, in the 
event of receiving feedback from users, will supplement the existing version with 
elements that may help to better understand and use the platform. The authors also 
plan to develop short instructional videos to further facilitate the management of 
the platform for both the administrator and the teachers. 
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